Nebraska Department of Education
Nebraska Student and Staff Record System (NSSRS)
www.education.ne.qov/nssrs

Export File from Data Manager and Import into Microsoft Excel
EDIT 09/04/2015

1. Logon tothe NDE Portal.

,,oﬂa,Si‘_mm/g12 Collection Announcements
Login ID:

2007-2008 Annual Financial Report Online System

l._i

The 2007-2008 Annual Financial Report Online System is now available. Submissions of the AFR, Poverty Narrative and LEP

Password: Narrative are due by November 1,2008.
' ) 2008-2009 NCLB Consolidated Application . . o
Sign In The 2008-200% NCLE Consolidated Application became available Wednesday, September 10, 2008. This application is due to
NDE by Friday, November 7, 2008. For more infarmation, please contact yvour NCLB Consultant {click on the "Contact Us" link
' Fegister on the bottom of any NCLE application page).
' Forgot Password State Aid Collections Are Open in the CDC

2. Goto the Student & Staff (NSSRS) tab.

Training

Data GMS Student & My Forms Viewear
Collections Staff ([NSSRS) B Profile Links

3. Click on the Data Manager.

Videos

Activation Nam

Code(s)
Available | Edit/Remove | NSSRS Data Manager

Available | Edit/Remove | NSSRS Secured Information Website
Available | Edit/Remove | NS5RS Validation
Available | Edit/Remove | Student Unique Identifier (Unig-I0C)

4. Click on Data Submission in the menu at the top then select Batch Manager from the drop down menu.

eScholar Data Manager HOME DATA SUBMISSION ¥ SYSTEM ADMINISTRATION REPORTS EDEN MODULE

Upload Files

. File Manager

Batch Manager
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5. Find the batch that has the file you want to download
a. Ifyou do not see the batch you are looking for, you may need to change the
Date From click Filter to find the batches uploaded during a specific time.

Batch Manager Change District | Logout| &y

IMPORTANT: **Hiding batches from the list does NOT delete the batches from the system

BATCHES SEARCH

BATCH STATUS: DATE FROM: / DATE TO
Al v 08252015 ] 0811412015 = FILTER [i’ﬁ

y  oACHID BATCHTIPE  coumenTs WODIFIED TIME  BATCH STATUS  DATA STATUS  ACTIONS
14 2015-08-05 =
584 Dataload bo1r Complete
44 2015-08-05 =
2015-08-03

11882  DataLoad i Complete

b. If you still do not find your batches you uploaded, you can use the Search feature to search by Batch ID,
Comments, Status, Hidden Batches and Templates. Select the radio button to the left of the desired
search option. Complete the form appropriately; click Search.
Note: Text fields cannot be left blank.

Batch Manager Change District|  Logout | :“!‘/-

IMPORTANT: The resulis returned from this search are limited to @ maximum of 200 records

—
BATCHES

SEARCHBY: @ BATCHID COMMENTS STATUS HIDDEN BATCHE § TEMPLATE

Bateh 10 <+—

Search All Available Districts
Search :

—_— SEARCH

6. Click on the View Details button under the Actions Column.

BATCHES | SEARCH

FILTER "

BATCH STATUS DATE FROM: DATE TO

Al v D8/25/2015 3 08/14/2015 E FILTER %J

BATCHID BATCHTYPE COMMENTS MODIFIED TIME BATCH STATUS DATA STATUS ACTIONS /
2015-07-31

11561 Data Load Staff for testing 0757 Complete
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7. Again, click on the View Details button under the Actions column.

BATCH FILE S
FILEID FILE NAME UPLOADED TIME SR AC_IM
) 21858 O00-0000_STAFF_SNAPSHOT_201507311402.C8V 2015-07-31
Displaying 1 -1 of 1 PAGE10OF1

EDIT BATCH COMMENTS ‘ | CLONE SELECTED FILES IN BATCH ‘ “

8. Click on the General Information tab.

FILE DETAILS - BATCH ID: 11561; FILE ID: 21858; FILE NAME: 00-0000_STAFF_SNAP SHOT_201507311402.CSV

ENERAL \NFORMATIO WALIDATION INFORMATION  ETL INFORMATION

00-0000_STAFF_SNAPSHOT_201507311402.CSV

ASSOGIATED TEMPLATE STAFF SNAPSHOT
DATA COLLECTION: K12 Admin Collection
FILE ID: 21858

BATCH ID: 11561

UPLOADED TIME: 2015-07-31 07:51
HEADER RECORD PRE SENT: Yes

DELIMITER: 0

BATCH STATUS: Complete

FILE STATUS Complete @
UPLOADED BY: Jill_training
UPLOADED TIME: 2015-07-3107:51
UPLOADED VIA: HTTP

LAST MODIFIED BY: jill_training

LAST MODIFIED TIME: 2015-07-31 07:51
ARCHIVED. No

ARCHIVED TIME:

SOURCE FILE

FILE TYPE FILE NAME RECORDS LAST MODIFIED DATE VIEW FILE CONTENT /

Source File 00-D000_STAFF_SNAPSHOT_201507311402 C8V 32068 2015-07-31 0751

9. Click on the View File Source button.
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10. Click on the Download File button.

Source File

00-0000_STAFF_SNAPSHOT_201507311402.C5V

STAFF SNAPSHOT
21858

11561

2015-07-31 07:51

Yes

32968

11. Click Save to your computer (Do not select open)

e
| DOWNLOAD FILE (ZIPPED) | ({ovw LOAD FI LE‘D “

Note: It is important to save the Source file to a location that can be easily found again.

STEPS TO IMPORTING .csv or .txt file with Microsoft Excel 2007, 2010 and 2013

Now that you have your file downloaded and saved from

NSSRS Data Manager, you can now update this data with

corrections and then resubmit. The best way to update this information is to use Microsoft Excel. Do not OPEN this
document in Excel. You will need to IMPORT the file into Excel. When you are done making the corrections you will
need to save the file as a CSV (Comma delimited) (*.csv) using the correct NSSRS naming convention.

The steps below will work with the 2007-2013 Versions of

1.
2.

Open the Excel Program
Select the Data tab on the Ribbon at the top on the

Excel, the program look and feel may be slightly different.

screen.

NOTE: A blank Excel workbook must be open for the “Data” tab to be available.

(Oa) S& - Bookd - Microsoft Excel - =
= Home Insert Page Layout Fnrmu\amew View Add-Ins @ - = x
5 From Access LY 5 ﬂ |G ca e 8 [z T . Clear _% E‘g |54 Data validation v | % Group v 43
3 From Web - g Ml ZA {» Reapph === [Fa Consolidate < Ungroup = =
] From Text tom mhfr Existing Mm.m = T 0 Advanced D EmOE b What-IF Analysis || (2] Subtotal
| Sources~ | Connections || Al Columns Duplicates =7

Get External Data Cannections Sort & Filter Data Tools Outline =

[ AL - @ %]

I a B c D E F G H 1 1 K L M

8 I
2
3 4

a
5
6 4
7 4
8
9

10|

1|

12

M 4 b W] Sheetl Sheet? ~Sheet3 ./ ¥J A [ m

[EEErTTe

7 -
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3. In the “Get External Data” group, click From Text.

Book2 - Microsoft Excel

i/En Ho-c-B& )+
6o

Home Insert Page Layout Formulas Data Review View Add-Ins
(g5 From Access %_ L ] Ij:-ﬂ Connedions || | [Tz N i Clear
[ = & AN 7
l._-} From Web . : 31 Properties i Reapply
From Other Existing Refresh il Sort Filter \';
Sources~ | Connections || All» == Edit Links 7 Advanced
Get External Data Connections Sort & Filter
| Al @ 5|
A | B c D E F G H 1

L1

B

4. Browse to find the file (.csv) and click on the Import button.

Note: The file does not appear; make sure “all files” is selected from the file drop down.

Il [ Favorites

B Desktop

= libraries

[ Microsoft Office Excel

{4 Recently Changed

(=, tmport Text File - — — S =
()=l » NSSRS Files ~ | €9 [ search NssRS Fites 2]
@-\‘J ‘ = p— ——‘—’.‘l =
Organize = New folder B - 0 @

| £%5]99-9999_STUDENT_200907271031.CSV |

File npame: 99-9999 STUDENT_200907271031.C5V =

Text Files (*.prn;*.bd; ™. csv)

Tools

Text Files (*.prn;* bt csv) -

5. The Text Import Wizard will appear. Select the Delimited radio button. Click Next.

-
Text Import Wizard - Step 1 of 3

— =

The Text Wizard has determined that your data is Delimited.

If this is correct, choose Mext, or choose the data type that best describes your data.
Criginal data type
Choose the file type that best describes your data:
i - Characters such as commas or tabs separate each field.

Fixed width - Fields are aligned in columns with spaces between each field.

Startimport at row: | 1 || File origin: 437 : OEM United States [~]

Preview of file C:\Users'\Aimee\Desktop\NSSRS Files\99-9999_STUDENT_200907271031.C5V,

1 PISTRICT CODE, LOCRTION CODE, SCHOOL YEAR DATE, STUDENT ID, SOCIAL SECURITY i -~
|2 bs-9393, 001, 2010-06-30, 4348002518, |, , ,, 11,,,,1995-04-28,F, ., 0vrrsss W, [

: < Back [ Next > J[ Finish

.
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If the file you are importing is comma-delimited (*.csv) un-check the Tab checkbox and
check the Comma checkbox. Click Next.

NOTE: The data in this window should display in columns if the correct delimiter (tob or comma) is selected.

Text Import Wizard - Step 2 of 3 ? P

This screen lets you set the delimiters your data contains. You can see how your text is affected in the preview
below.

Delimiters
[[]Tab

[C] Semicolon [ Treat consecutive delimiters as one

* Comma
[T space
[ other:

Text qualifier: |* |z|

Data preview

ISTRICT CODE TION_CODE SCHOOL_YEAR DATE [STUDENT ID [SOCIAL SECURITY ] o
5-9933 o1 010-0&-30 (348002518

cancel | [ <Back | [ mext> | [ pmsh

Select all of the data in the Data preview window by clicking in the first column, scroll to the last column, holding
down the SHIFT key click in the last column.

Text Import Wizard - Step 3 of 3 ? =

This screen lets you select each column and set the Data Format.
Column data format

@ General

‘General' converts numeric values to numbers, date values to dates, and all
) Text remaining values to text.

e fwor ]

_) Do not import column (skip)

Data preview

[ S— nezal

nezzl nezzl
LOCETION_CODE [SCHOOL_YEAR_DATE STUDENT_ID SOCIAL_SECURITY_NUN <
01 g0l0-08-30 4948002518

r

Text Import Wizard - Step 3 of 3 ? =

This screen lets you select each column and set the Data Format.
Column data format

@ General

‘General' converts numeric values to numbers, date values to dates, and all
) Text remaining values to text.

v o 1]

") Do not import column (skip)

Data preview

OR [FUNDING_DISTRIC
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8. Change the data format to text by selecting the Text radio button. Click the Finish button.

Text Import Wizard - Step 3 of 3 ? 29

This screen lets you select each column and set the Data Format.
Column data format
_ General

* 'General' converts numeric values to numbers, date values to dates, and all
L remaining values to text.

e o3

~) Do notimport column (skip)

Data preview

Te
DATE ETUDENT_

cancel | [ <Back )

9. Select the worksheet you want the data to be imported into. Select OK.

i N
Import Data ? 2
Where do you want to put the data?
@ Existing worksheet:
—$AS1 e
| New worksheet
(rsers. | o
L "

Tip: Replace Column Headings with numbers instead of letters

Microsoft 2007. Click the “Office” button =» Options =» Formulas = R1C1 Reference Style

Microsoft 2010 and 2013 Click the “File” Tab =» Options = Formulas = R1C1 Reference Style

Excel (ptions:
Popular =r !
f,: Change options related to formula calculation, performance, and error har
| Formuias
Praofing Calculation options
Save Waorkbook Caleulation ] Enable jterative cal
oy 2
sdvanced S Rt Magimum Iteration:
S ) Automatic except for data tables
E Maximum Change:
Customize 0 Manual
Add-Ins

Trust Center Working with formulas

E B1CI reference style

[¥] Formula AutoComplete

[#] use table names in formulas

[¥] Use GetPivotData functions for PivotTable references

Resources

SN ° NEBRASKA DEPARTMENT 9f EDUCATION

Page | 7



Export File in Data Manager and Import into Microsoft Excel | 09.04.2015

Saving Corrections
Once you have the file open in excel you can review, make corrections and delete records

(Don’t forget to update your SIS). Follow the steps below to save the file as a .csv (comma separated value) in order to
upload to NSSRS Data Manager.

1. Click on File (in 2007 click on the “Office Button”) choose Save As from the menu

.i. Home 1
| save

Save As

[ Open
,__f Close
2. Within the Save As window choose the folder/location you want to save the file.
3. Click on the dropdown arrow at the end of the Save As Type option and choose “CSV (comma delimited)”
Bookl.csv -
[csv (Comma delimited) (r.csv) -

Excel Workbook (*xisx)

Excel Macro-Enabled Werkbook (*dsm)

Bxcel Binary Workbook {*xish)

Excel 97-2003 Workbook (*s)

XML Data (*xml)

Single File Web Page (*:mht;".mhtmi)

Web Page (* htm;* html)

Bxcel Template ("t

Excel Macro-Enabled Template (*xitm)

Bxcel 97-2003 Template (*xit)

Text (Tab delimited) (*.6t)

Unicode Text (")

XML Spreadsheet 2003 (*xml)
 Microsoft Excel 5.0/95 Workbook (*.xIs)

iy 5 (Comma geimeea vies - ]

Formatted Text (Space delimited) (*prn)

Text (Macintosh] (*.6¢)

Text (MS-DOS) (*.&xt)

€SV (Macintosh) (.csv)

CSV (MS-DOS) (*.csv)

DIF (Data Interchange Format) (.dif)

SYLK (Symbolic Link] (*.slk)

Excel Add-In (*xlam)

Bxcel 97-2003 Add-In (*xla)

5 Doeement ap)
OpenDocument Spreadshest (*.ods)

4, In the File Name field type the appropriate file specific naming convention (see below)
File Specification File Naming Convention Pattern
Assessment Fact Hi-#tH## assessment_fact_ YYYYMMDDHHMM.xxx
School Enroliment #it-##Ht#_school_enroll_YYYYMMDDHHMM.xxx
Special Education Snapshot Hi-#tH# special_ed_snap_YYYYMMDDHHMM.xxx
Staff Demographics Hit-H#iH#_ staff_demographics.zzz
Staff Position Assignments Hi-#t# staff_position_assignments.zzz
Student H#-#iH# student_YYYYMMDDHHMM.xxx
Student Grades Hi-### stud_grades_YYYYMMDDHHMM.xxx
Student Snapshot Hi-#t## stud_snapshot_YYYYMMDDHHMM.xxx
Student Summary Attendance H{-### stud_att_sum_YYYYMMDDHHMM.xxx
Post School Survey H#-#t## post_school_survey_ YYYYMMDDHHMM.xxx
Programs Fact Hit-H#iH#_programs_fact_ YYYYMMDDHHMM.xxx
Title | Programs Hi-#t## titlel_programs_YYYYMMDDHHMM.xxx

Where: ##-#### is the NDE-assigned District Code YYYYMMDDHHMM is a date and time stamp

5. Click Save

N ° NEBRASKA DEPARTMENT 2t EDUCATION
N Page | 8



Export File in Data Manager and Import into Microsoft Excel | 09.04.2015

6. You will get two warning messages from Excel Click OK and YE
PMicmstt Excel ﬂ‘

The selected file type does not support workbooks that contain multiple sheets.

_L «To save only the active sheet, dick OK.
«To save all sheets, save them individually usj ifferent file name for each, or choose a file type that supports multiple sheets,

=

Microsoft Excel

93-8953_STUDENT _200307271031.C5V may contain features that are not compatible with CSV (Comma delimited). Do you want to keep the
__ workbookin this format?
)+ To keep this format, which leaves out any incompatible features, dick Yes.
+Ta preserve the features, cick No, Then save a copy in the latest Excel format.

+To see what might be lost, cick Help.
m—\ ErE) EmiETs
» i

7. Now you can close the Excel file. It will ask if you want to save the file click Don’t Save

Microsoft Excel

Ay
| . Do you want to save the changes you made to
'99-5999_STUDENT_200907271031.C5V?

e

N—

Now you can upload the corrected file to NSSRS Data Manager.
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